SHELL ELEMENTS
BENDED PLATE AND THIN-WALLED BEAM

1. INTRODUCTION

Shell elements geometry is defined by the nodefhenmiddle surface. Thickness | applied as a
parameter. Stress system includes membrane artingestresses. Each layer parallel to the
middle surface acts in plane stress. Distribuotbnormal and shear stress along thickness iadine

(see Figure below). Shell elements can be usedottehthin walled structures (vessels and plates)
as well as thin-walled beams. There are six degrédéeedom (DOF) at each node: three linear
displacements and three angles of rotation.

SHTOR)
SX{MID)
SX {BOT}

SHELL Element Stress Output

top surface
Otop' Omid

(R~
) . ___+:é§__

/ Opot ) ‘4—
Omid Obottont Omid
_de_>

middle surface

bottom surface
total stress membrane stress bending stress

Fig. The membrane and bending stress components in the shell
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2. PROBLEM DESCRIPTION

2.1. Bending of therectangular plate
The goal of the analysis is to find deflection aticbss components in rectangular plate supported
along edges on pin supports and loaded with constaface load).

Data:q=0.1MPa, a=200 mm, b= 300mm, h=4mm, E=2/0° MPa, v=0.3
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2.2. Bending of the thin-walled beam
The goal of the exercise is to find deflection atreésses in the thin-walled cantilever beam loaded

with concentrated load.
Data:P=10 kN, I=5m, B= 100mm, H= 240mm, hi= 13mm, h,= 9mm, E=2/0° MPa, ¥=0.3
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3. TYPICAL COURSE OF NUMERICAL ANALYSIS

Taking double symmetry of the problem we can Builbf the analyses plate. Convenient units are:
mm, N, MPa.

3.1. Bending of the plate

3.1.1 Preprocessor

\ 1. Create rectanglér eprocessor >Create>Rectangle> By Dimensions
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3. Define material propertie®r eprocessor >Material Props>Material Models:
Sructural/Linear/Elastic/Isotropic: EX=2e5MPa, PRXY=0.3
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4. Define element thicknesBr epr ocessor >Section>Shell> Lay-up>Add/Edit
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5. Define size controlPr eprocessor >Meshing>Mesh Tool>SizeCtrl>Global
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6. Generate meslr eprocessor >Meshing>Mesh Tool>Mesh>AregQuad)
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3.1.2. Solution

Define boundary conditions

9. Define pin support on along edg&slution>Define Loads>Apply>Structural>Dispalcements>Ondsn
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11. Apply surface loadSolution>Define Loads>Apply>Structural>Pressure>0n Areas

ANSYS Main Menu [y
Al PRES X
B Preferences G Clowrr A\ Apply PRES on areas x|
Preprocessor —_— [SFA] Apply PRES on areas asa
@ Solution @ Single C Box
4 . IF Constant value then: ~—_—~—
Analysis Type . et VALUE Load PRES value _0.1
& Define Loads
Settings SEE = g LKEY Load key, usualy face no.
= Appl Maximm = 1
Ep gt):uctural Minimm = 1 (required only for shel elements)
= DispTICETTeR Area No. = 1
(@ List of Ttems
€ Min, Max, Tnc

BAOn Areas]
2 0n Nodes
Z0n Node Componet

2 0On Elements Ao

2 0n Element Compo

& From Fluid Analy ===
2 0n Beams pick a11|  melp
Temperature
Inertia
B Pretnsn Sectn
B Gen Plane Strain
Other
Field Surface Intr
Field Volume Intr
Initial Condit'n
Load Vector

oK Apply Cancel Help

12. Solve the problenolution>Solve> Current LS

& Preferences LINES
= Preprocessor
e Solution YRR N
Analysis Type U
@ Define Loads Xl

Load Step Opts o 9
SE Managem‘;nt ( [SOLVE] Begin Solution of Current Load Step

Results Tracking Review the summary information in the lister
TS0lve indow (entitied "/STATUS Command"),
en press OK to start the solution.

Eﬁa}:’rat:aismu‘ [ oK | cencel | Help |

@ Multi-field Set Up &%
@ ADAMS Connection -
= Diagnostics
B Unabridged Menu
= General Postproc
& TimeHist Postpro
= Topological Opt
= ROM Tool

Ex_3_Plate and thin walled beam.doc dr inz. Piotr Marek



3.1.3. General postprocessor

Show the results as contour maps
Show displacements normal to the plate (UZ), bepdiress: stress components (SX, SY)

| 13. Plot displacements UZ |
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15. Plot stress component in Y (SY) |
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3.2. Thin-walled beam

3.2.1 Preprocessor

\ 1. Create keypoint in central point (0,Q,B) eprocessor >Create>Keypoint>In Active CS
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3. Create lines by keypointBr eprocessor >Modeling>Create>Lines> Stright Line
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5. Create lines by keypointBr eprocessor >Modeling>Create>Lines> Stright Line
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ocessor >Element Type>Add>(SHELL181 i SHELL281) |
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12. Reflect areasPr epr ocessor >Modeling>Reflect>Areas
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Multi-field Set Up

14. Merge geometryPreprocessor >Numbering Ctrls> Merge Items>Keypoints

ANSYS Main Menu

B Preferences

= Preprocessor
Element Type Ii Merge Coincident or Equivalently Defined Items

Real Constants [NUMMRG] Merge Coincident or Equivalently Defined Irems

Material Props Label Type of item to be merge ~
Sections

& TOLER Range of coincdence l:l
Modeling

AREAS
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=
& Compress Numbe WSSO
& Set Start Number SWITCH Retain west/highest? LOWest number > 16

B Reset Start Num
B Start Num Status

=Add Num Offset o | oy | _conee | _ep |
15. Generate meslreprocessor >Meshing>Mesh Tool>Mesh>Areg&Quad)
ANSYS Main Menu

= Preferences Element Attibutes TS
e Preprocessor i
Element Type Global ~]  set 24 b o
Real C _—
Material Props [~ smersize @ single ( Box
Sections 7 ol C Polygon ( circle

C Loop

@ Modeling Fine 6
a i

Count.

Mesh Attribut gize contrale: Maximun
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[=]MeshTool i = o M

Size Cntrls

[T

@ Mesher Opts =~ Areas Set Clear T
@ Concatenate | = e @ List of Items
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& Tet Mesh F
wInterface M_"~"° S ok | |

Modify Mesh Reset. Cancel
D) e
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Clear
@ Checking Ctrls ~ Sh{®
= Numbering Ctrls ¢ Free
Archive Model
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FLOTRAN Set U|

Multi-field Set Uj m‘— Gleer
@ Loads S—
= Physics _—
Path O
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16. Plot elements using thickness description \

:(Plot PlotCtrls | WorkPlane Parameters Macro MenuCtrls Help

Vlew Semngs

UM_DB Numbering ...

e Wlndow Controls

nts Erase Options

ps Animate
Annotation

” Device Options ...

fbutes Redirect Plots

Is Hard Copy

:::: Save Plot Ctrls ...
Restore Plot Ctrls ...

nts Reset Plot Ctrls
Capture Image ...

S Restore Image ...

> Swee Write Metafile

::’;:o Multi-Plot Controls ...
eeh Multi-Window Layout ...
:sh

3.2.2. Solution

Define boundary conditions

Best Quality Image

Size and Shape

dge Option
| S e |
*  Contours %
" Graphs k
, Colors g
Light Source ...
,  Translucency r
] Texturing
Background

Multilegend Options k
Floating Point Format ...

Displacement Scaling ...
Vector Arrow Scaling ...

> Shell Normals ...
Solid Model Facets ...
Symmetry Expansion

17. Define symmetry B.C. on lineSolution>Define Loads>Apply

>Structural>Dispalcements>Symmetry B.C.>On Lines

ANSYS Main Menu

Q)|

| Preferences
Preprocessor
Solution
Analysis Type
e Define Loads
Settings
@ Apply
& Structural
= Displacement
20n Lines
2 0n Areas
2 0n Keypoints
20n Nodes
20n Node Components

20n Areas
E0n Nodes
@ Antisymm B.C.

@ Pick (" Uspick

(@ single (" Box \SSS
€ Folygon (- cizcie - \ F‘S'ZS
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® Temperature
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B Gen Plane Strain
Other

@ Field Surface Intr

- //

[
|
|~
|

\\

e

e
/ /

18. Constrain central keypoint on Y (UY=@olution>Define Loads>Apply

>Structural>Dispalcements>0On Keypoints

ANSYS Main Menu

ol

| Preferences
Preprocessor
Solution
Analysis Type
& Define Loads
Settings
@ Apply
& Structural
= Displacement
A On Lines

».0Qn Node:
20n Node C:

=
~ [DK] Apply Displacements (U,ROT) on Keypoints
Lab2 DOFs to be constrained

Apply as

Constant value -
If Constant value then:
VALUE Displacement value l:l

KEXPND Expand disp to nodes? I~ No /

oK Apply Cancel

2 Symmetry B.C.
20n Lines
A...with Area
2 0n Areas
50n Nodes

Antisymm B.C.

Force/Moment
Pressure
Temperature
Inertia
B Pretnsn Sectn
B Gen Plane Strain
Other

Field Surface Intr

[DK] Apply Displacements (U,ROT) on Keypoints

|| / Lab2  DOFs to be constrained

~
Apply as

| / I Constant value then:
| VALUE Displacement value l:l
/ KEXPND Expand disp to nodes? ™ No

- /
e oK Apply Cancel Help.
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19. Apply concentrated load on keypaiSblution>Define Loads>Apply
>Structural>Forces/Moment>0On Keypoints

ANSYS Main Menu Bl
B Preferences LI
Preprocessor [FK] Apply Force/Moment on Keypoints
& Solution @ pick  Unpick Lab  Direction of force/mom
Sn;lysf T{ipe @ Single (" Box Apply as Constant va\ue ~ 3
Fbetine -oads € Pelygen ( circie I Constant value then: ~ES
Settings € Loop
@ Apply

& Structural

] Dlsplacement Maximam

VALUE value ‘ -~ s
Count 1 ]

x
€@ ok | Apply Cancel e | /4\
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/ s
Spont @ List of Items / // //\
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® Temperature / e -
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B Gen Plane Strain M ﬂl

Other

\\
\\
\

Pick a11|  melp

eld Surface Intr

Load Vector

Functions
Delete
Operate

ield Volume Intr
Initial Condit'n //

20. Solve the problentsolution>Solve> Current LS

ANSYS Main Menu &)
B Preferences AREAS
® Preprocessor TYPE NOUM
& Solution
= Analysis Type
@ Define Loads F
= Load Step Opts
= SE Management (C x|
B Results Tracking  [SOLVE] Begin Solution of Current Load Step
Ve
ElCurrent LS| Review the summary information in the lister
& From LS Eil window (entitled "/STATUS Command"),

& Partial Solu
= Manual Rezoning
= Multi-field Set Up

then press OK to start the solution.

ok ] cencel | Help

= ADAMS C

= Diagnostics

5 Unabridged Menu
General Postproc
TimeHist Postpro

= Topological Opt

@ ROM Tool
DesignXplorer
Design Opt

Prob Design

3.2.3. General postprocessor

Show the results as contour maps
Show displacements i Y (UY), bending stress: norstr@ss (SZ) and shear stress in the web (SYZ2).

| 21. Plot displacements in Y (UY) |

ANSYS Main Menu_ [T e e S x|
B Preferences ~ Item to be
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Solution Favorites il
= General Postproc | @ Nodal Solution &
5 Data & File Opte @ DOF Solution )
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Read Results Ll Y-Component of displacement
Failure Criteria i‘ & 7_Camnnnant nf dienlanamant _},J _44.508
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-10.825
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B Results Viewer -5.212
& Write PGR File
= Nodal Calcs .402014
e Element Table
= Path Operations
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22. Plot normal stres§SZz)

TA Contour Nodal Solution Data i

x|

ANSYS Main Menu all
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= Data & File Opts
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23. Select elements attached to ar@eeb e ements)
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24. Plot shear stress in the wgbYZ)
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25. Define path along web height

B Results

a General Postproc
B Data & File Opts
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Plot Results @ e ¢ B
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26. Map shear stress onto path DG

and plot shear stress along height of the (wéth nodes)

e General P

EData & A
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= Plot Re
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4. INTERPRETATION OF THE RESULTS. TASKS TO BE DONE

Solve the problems:
a) Bending of the plate using SHELL181:
- rough mesh with about 20 eleme(&SZE=30) (Model 1a),
- dense mesh with about 150 eleméBS ZE=10) (Model 1b),

b) Bending of the thin-walled beam:
- model using 4 noded SHELL18#ddel 2a)
- model using 8 noded SHELL28uddel 2b)

Discuss the results.

Model 1a Model 1b Model 2a Model 2b
PLATE (SHELL181) | (SHELL181) BEAM 4 noded 8 noded
rough dense (SHELL181) (SHELL281)
No. of nodes No. of nodes
No. of elements No. of elements
UZmaX UYmax
Sxmax Szmax
SY max SYZpax "
fmax fmax
O— max O-G
X
0— max O—D
y
Tmax

Plots needed (should be archived during program session for each model):

For plate: for beam:
1) FE mesh. 1) FE mesh.
2) UZ(x.y) 2) UY(xy)
3) SX(x.y) 3) SZ(xy)
4) SY(X,y) 4) SYZ(x,y) inthe web
5) graph: SYZ along DG (point 26)

Final report:

1) Introduction

2) Assumptions for the modeling

3) model description (solid model, mesh, boundary conditios and loads)
4) Results

5) Results in the Table

6) Discursion

7) Conclusion
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